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In This Version 
This release of WLS SPI provides: 

• Support for WebLogic Server 9.1 and 9.2  

• Support for hardware cluster Failover  

⎯ HP-UX MCSG cluster 

• Improved error logging and fault tolerance in Discovery functionality  

• BEA Validation (complete)  
New tools and metrics added:  

⎯ Tools  

− Metric Reports tools group  

o B238_EJBCacheHitPct: Generates report for percentage of EJBs in the cache in use  

− WebLogic application group  

o View Application Activation Status: Allows you to view the activation status of applications 
running on a WebLogic Server  

o View Application Timeout: Allows you to view the time left before retiring applications 
running on a WebLogic Server will timeout  

⎯ Metrics  

− B016_GloThrePoolOverload: Global Thread Pool overload condition 

− B017_WorkloadMgrOverload: Workload Manager overload  

• Application Instance Support:  Application instance level monitoring will allow you to fine tune the 
WebLogic Server components at the application level 

• Support for AIX 5.3  

• Support for Intel Xeon 64 bit processor - EM64T 

• Support for HP-UX 11.23 Itanium 
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Documentation Updates 
The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version. 

• Publish date, which changes each time the document is updated. 

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://ovweb.external.hp.com/lpe/doc_serv/ 

In the Product list, click the product name. 

2 In the Version list, click the version number. 

3 In the OS list, click the OS type. 

4 In the document list, click the document title. 

5 To retrieve the document, click Open or Download. 

NOTE: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following URL: 

http://www.adobe.com

Installation Notes 

Software Requirements 

Service Navigator is not required to run the WLS SPI. However, if you want to view service maps, Service 
Navigator must be installed. 

 

Management Servers 

Component Supported Versions 

HP OpenView Operations for UNIX 
 

7.1, 8.1, 8.2 
 

 

 

Managed Nodes 

Component 

 

Supported Versions 

 

WebLogic Application Server 6.1 sp1+ HP-UX 11.00, 11.11 
HP Tru64 5.1A, 5.1B, 5.2  
Solaris 2.6, 7.0 
Windows 2000 

WebLogic Application Server 7.0 HP-UX 11.00, 11.11 
HP Tru64 5.1A, 5.1B, 5.2  
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Solaris 7, 8, 9, 10  
Windows 2000, 2003 IA64  
Red Hat Enterprise Linux AS/ES 2.1 

WebLogic Application Server 8.1 sp1+ HP-UX 11.00, 11.11, 11.23, 11.23 IA64 
HP Tru64 5.1A, 5.1B, 5.2  
Solaris 8, 9, 10  
Windows 2000, 2003 IA64  
Red Hat Enterprise Linux AS/ES 2.1 
(32 bit), 3.0 (32 bit), 4.0 (32 bit) 
SuSe Linux ES 8.0 (32 bit), 9.0 (32 bit)  
AIX 5.1, 5.2, 5.3 
Intel Xeon 64 bit processor - EM64T 

WebLogic Application Server 9.0 , 9.1, 9.2 HP-UX 11.11, 11.23, 11.23 IA64 
HP Tru64 5.1A, 5.1B, 5.2 
Solaris 8, 9, 10 
Windows 2000, 2003 IA64 
Red Hat Enterprise Linux AS/ES 3.0 
(32 bit), 4.0 (32 bit)  
SuSe Linux ES 8.0 (32 bit), 9.0 (32 bit) 
AIX 5.1, 5.2, 5.3 
Intel Xeon 64 bit processor - EM64T 

HP OpenView Performance Agent  (UNIX or 
Windows) 

UNIX C.02.00+, Windows C.03.00+, 
Linux 4.x 

HP OpenView Reporter 
 

2.x, 3.5, 3.6, 3.7 

HP OpenView Performance Insight 
 

5.0, 5.1 
 

HP OpenView Performance Manager (HP-UX, 
Solaris, Windows) 
 

4.x, 5.x 
 

PeopleSoft WeblogicVersion: WebLogic Temporary 
patch 2 for PeopleSoft 

Installation Requirements in a Non-Root HTTPS Agent Environment 

If you are running or planning to run a non-root HTTPS agent on a UNIX managed node (OVO 8.x only), you 
must install the OS-dependent Sudo software package on that UNIX managed node. Sudo is free software 
available from http://www.sudo.ws. The OS-dependent software packages are available at the bottom of the 
download page (http://www.sudo.ws/sudo/download.html). 
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Enhancements and Fixes 
The following items (identified by error tracking number) are fixed in the current software release.  More 
detailed information about enhancements and fixes can be found online at the HP Online Software Support 
web site. The first time you visit this site, you must enter your HP passport information. To set up your 
passport profile, go to: http://support.openview.hp.com/support.jsp?fromOV=true. 

QXCR1000316160: wasspi_wls_ca -r messes up the SERVER numbers in SiteConfig.  
QXCR1000318056: Perl command "use lib" not effective.  
QXCR1000320341: Tracing not working on WLS.  
QXCR1000318561: Discovery not working for T3S and servers created in non-default directories. 
QXCR1000337519: No mention of Configuring WLSSPI for WLS running on HTTPS (Inactive) 
QXCR1000317620: Metric 85 should use UserLockoutManagerMBean for WLS 7.x and 8.x 
QXCR1000328023: deprecated attribute "CacheHitCount" in our MetricDefinitions.xml file 
QXCR1000357842:WLSSPI4.00: customer requests hotfix for metric85 (Inactive) 
QXCR1000337628: [WLSSPI 4.00] ovtrc3.jar is listed in "Missing Files" by Verify application 
QXCR1000381700: collector processes hanging in RHEL 4.0 (Kernel 2.6) environment. 

Known Problems, Limitations, and Workarounds 
 

• Problem: On the Windows managed node, the Verify tool gives a message saying there is a version 
mismatch for the file wasspi_wls_trace.pm 

Workaround: This will not cause any problem in the functioning of the SPI. It can be ignored.  

• Problem: In a non-English environment, the message browser does not display error messages 
correctly. 

Workaround:  Change the character set of the WLSSPI Error Log template and redeploy the template. 
For example, change the character set from “Shift-JIS” to “Japanese EUC.” 

• Problem: When multiple managed nodes are selected when running the Discover WebLogic or 
Configure WebLogic applications, or if the Discover WebLogic and Configure WebLogic applications are 
run at the same time, the SPI may report errors for one or more selected managed nodes because the SPI 
configuration file (SiteConfig) for one or more managed nodes has been misplaced. 

Workaround:  Run the Configure WebLogic application for each managed node that is reporting errors 
(run the application on each managed node one at a time). 

• Problem: The perl installed with the OVO agent fails to find the OVO perl modules if another 
application (such as Oracle Application Server) sets the PERL5LIB environment variable to point at 
locations that do not include the OVO perl lib location.  

Workaround 1: Set the PERL5LIB system environment variable: 

1 Prepend C:\Program Files\HP OpenView\nonOV\perl\a\lib (the OVO perl lib path) to the 
PERL5LIB system environment variable.  

2 Kill the OVO agent: opcagt -kill  

3 Restart the OVO agent: opcagt -start  

4 Check the OVO environment: ovdeploy -cmd set  
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5 If the PERL5LIB variable is not set correctly in the OVO environment but the system variable is set 
correctly, reboot the system. 

Workaround 2:  

1 Delete the PERL5LIB system environment variable.  

2 Reboot the system. 

3 Run the Discover application. 

Workaround 3: Run the discover script on the target node. Enter the following: 

1 cd /var/opt/OV/bin/instrumentation 

2 wasspi_wls_perl –S wasspi_wls_discovery.pl 

NOTE: The service map is not generated when the discover script is run locally (is not run from the 
OVO management server). 

• Problem: The wls.log file grows very large.   

Workaround: Limit the size of the data saved to the log file each time the logfile encapsulator is run. In 
the SPIConfig file (located in /var/opt/OV/wasspi/wls/conf/ or /var/opt/OV/conf/wls/ on 
UNIX platforms and /usr/OV/wasspi/wls/conf/ on Windows platforms), add the following: 

# maximum number of lines to save to the log file / run 
LOG_LINE_LIMIT=16667 
# maximum number of characters to save from each log file / run 
LOG_SIZE_PER_FILE_LIMIT=600000 

• Problem: When using WebLogic Server 6.1, getAttributes returns a null value.   

Workaround:  Install WebLogic Server 6.1 sp7 (service pack 7). 

• Problem: On managed nodes using the DCE agent, the /var/opt/OV/wasspi directory and SiteConfig 
file are not created when running the SPI Discovery or Configuration applications.  The problem may be 
that the component opctranm may be hung.   

Workaround:  On the management server, run the following commands: 

ovstop ovoacomm 
rm –f /var/opt/OV/share/tmp/OpC/mgmt_sv/magmgr* 
ovstart opc 

• Problem: When the WebLogic Server is started, multiple WLSSPI-0011.1: % of execute threads used 
(<VALUE>%) too high messages are displayed in the message browser.  

Workaround:  These messages can be safely ignored when the WebLogic Server is being started.  

• Problem: When the Self-Healing Info application is run on a Windows managed node, the output file 
may be hidden. 

Workaround:  If you do not see the file, do the following on the managed node: 

1 Open Windows Explorer. 

2 From the Tools menu, select Folder Options.  

3 Click on the View tab.  

4 Under Hidden files and folders, select Show hidden files and folders. 
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• Problem:  On a Solaris managed node, the ddflog and dsilog processes hang. The error message WASSPI-
1: Unable to create the lock file /var/opt/OV/wasspi/wls/datalog/ddflog.lck. File already 

exists. is reported and running the command ps –l shows that the ddflog_coda and ddflog or dsilog 
processes are hung. 

Workaround: On each Solaris managed node on which the problem occurs, do the following: 

1 In the /var/opt/OV/wasspi/wls/conf/SPIConfig file, set the DATA_LOGGING_EXECUTABLE_NAME 
property after the “#--------- Dynamic definitions -----------“ entry. DATA_LOGGING_EXECUTABLE_NAME 
explicitly sets the data logging program that is used (normally, the collector automatically 
determines the data logging program to use). 

If you are running OVPA, set the property to the following value: 

DATA_LOGGING_EXECUTABLE_NAME=/opt/perf/bin/dsilog 

If you are running CODA, set the property to the following value: 

DATA_LOGGING_EXECUTABLE_NAME=/opt/OV/bin/OpC/monitor/ddflog_coda 

2 Kill the hung ddflog_coda and ddflog or dsilog processes. 

Example excerpt from the SPIConfig file after setting the property: 

UDM_GRAPH_CAPACITY=50000 
UDM_PERF_CAPACITY=50000 
#--------- Dynamic definitions ----------- 
DATA_LOGGING_ENABLED=TRUE 
DATA_LOGGING_EXECUTABLE_NAME=/opt/perf/bin/dsilog 

• Problem: The "View Graphs" application does not work.  

Workaround:  On the OVPM Windows system, copy the file: 

\Program Files\HP Openview\newconfig\WLSSPI_Graphs.txt 

to: 

\Program Files\HP Openview\newconfig\VPI_GraphsWLSSPI.txt 

• Problem: On Linux nodes, the "Configure SPI" or "Discovery" application can fail without configuring 
the SPI on the managed Linux node.  This happens because some of the configuration processes require 
uudecode to be present on the local node. 

Workaround:  Ensure that uudecode is installed on the target managed node.  It is available in the 
SHARUTILS package. 

• Problem: The "Start WebLogic" and "Stop WebLogic" applications fail on Windows nodes if the USER or 
SERVER<n>_USER configuration property is set.  The application is trying to run the "su" command, 
which is only available on UNIX. 

Workaround:  Do not set the USER or SERVER<n>_USER property when configuring the 
SERVER<n>_START_CMD or SERVER<n>_STOP_CMD properties for Windows nodes. 

• Problem: The SPI's configuration log …/wls/log/config.log on a managed node grows without 
being managed for size.  This file is appended to whenever the SPI's configuration is run, either 
manually or when the discovery process finds a change that requires configure to run (such as a 
WebLogic server being added or removed).  Unless there are frequent changes to the environment 
requiring reconfiguration, this should not be a problem. 

Workaround:  Manually delete the file if it gets too large. 
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• Problem: WebLogic Server SPI cannot locate and therefore is unable to monitor the WebLogic log file 
when WebLogic Server is not started from the HOME directory.   This is only a problem in WebLogic 
Server 6.0 and 6.1. 

The location and name of the WebLogic Server log file is specified in the WebLogic Administration 
Console in the "Logging" tab on the server configuration page. If this log file is specified with a relative 
path, this path is relative to the directory in which the WebLogic Server is started. The default is the 
WebLogic home (WL_HOME) directory specified when the WebLogic SPI is configured. The startup scripts 
installed by BEA start WebLogic Server from its home directory.  

No means currently exists for querying the server for its startup directory.  So, if the WebLogic Server is 
started up in a directory other than WL_HOME and the log file is specified as a relative path, the WLSSPI 
may not be able to locate and monitor the WebLogic Server log file. 

Workarounds (choose either A, B, or C):  

(A) Configure the LAUNCH_DIR variable in the WebLogic Server SPI configuration file to define the 
location of the WebLogic Server startup directory. Please see Chapter 2 of the User’s Guide for details. 

(B) Ensure that WebLogic Server is started from the WL_HOME directory, which is the default if you use 
the startup scripts provided by BEA. Also, note that the WLSSPI will not recognize a fully qualified path 
name for the log file. You must use a relative path for the WebLogic Server log file in order for it to be 
located and monitored by the WLSSPI. 

(C) In the WLS SPI configuration file, include the fully qualified name(s) of the WebLogic Server 
logfile(s) you want to monitor. For multiple logfile entries, separate each logfile name with a comma. 

To edit the file: 

1 Run the WLSSPI→WLSSPI Admin→Config WLSSPI application to edit the file.  

2 Insert an additional line beginning with keyword SERVER<n>_LOGFILE as shown below, followed by 
the fully qualified file name:   

SERVER<n>_LOGFILE = <path>/<file_name_1>,</<path>/<file_name_2>

3 Save the file and deploy to the node. 

NOTE: This workaround is an enhancement to the syntax as documented in the HP OpenView 
Operations Smart Plug-in for BEA WebLogic Server Configuration Guide.  

• Problem: Two Netscape Navigator browser windows are launched when running the View Graphs 
application. The top window obscures the OVPM function buttons in the lower window.  

Workaround:  This problem only occurs with Netscape Navigator version 4.79. Use Netscape Navigator 
version 6.0 or higher. 

• Problem: The Web browser cannot be launched from an operator action after you have correctly 
configured the WLS SPI as instructed in the “Configure the Management Server to Launch your Web 
Browser” task in chapter 2 of the HP OpenView Operations Smart Plug-in for BEA WebLogic Server 
Configuration Guide.  

Workaround:   

1 Stop and restart the agent from a user other than root by entering the following commands on the 
managed node: 

opcagt –kill 
opcagt –start 

2 Run the operator action.  
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• Problem: Netscape fails to refresh graphing data. Specifically, when you use Netscape as the browser to 
graph your data (graphing capability included with Reporter 3.0 or higher), the browser fails to refresh 
when new selections are made.  

For example, in the OVO console after you drag and drop a managed node onto the WLSSPI Admin 
application View Graphs, Netscape appears and displays a blank WLS SPI graphing page where you can 
accept or change the following default selections: 

Server:  MyServer_1 
Graph Name:  Serverstat 
Data Range: 7 Days (ending now) 

By clicking Draw, you successfully generate the graph.  

However, when you select a different server, let’s say MyServer_2, you see that the graph that appears 
after you click the Draw button is the same graph/data as the one you just viewed (for MyServer_1).  

Workaround: 

1 In Netscape from the Edit menu select Preferences→Advanced→Cache. 

2 In the segment labeled Document in cache is compared to document on network, select radio button 
Never. 

3 After successfully generating the first WLS SPI graph, for any subsequent graphs, always change a 
minimum of two selections to refresh the data; for example select a different server and a different 
graph; or select a different graph and a different date range. Any two differing selections work to 
clear the current graph data from the browser cache. 

4 Note: The underlined text Refresh Graph Now at the bottom of the Web page does not work; when 
clicked, it may return the error: the parameter is incorrect. 

• Problem: For a managed node running Red Hat Linux 4 or Suse Linux 9.1 or 9.2, discovery and/or 
metric threshold monitor alarming is not functioning AND the following error message is found in the 
SPI error log: 

*** glibc detected *** double free or corruption: 0x0937d008 *** 

Workaround:  On the OVO agent, set the MALLOC_CHECK_ environment variable to 0 (zero) and restart 
the agent. 
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Support 
Please visit the HP OpenView support web site at: 

http://www.hp.com/managementsoftware/support

This web site provides contact information and details about the products, services, and support that HP 
OpenView offers. 

HP OpenView online software support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As a valued 
support customer, you can benefit by being able to: 

• Search for knowledge documents of interest 

• Submit and track progress on support cases 

• Submit enhancement requests online 

• Download software patches 

• Manage a support contract 

• Look up HP support contacts 

• Review information about available services 

• Enter discussions with other software customers  

• Research and register for software training 

NOTE: Most of the support areas require that you register as an HP Passport user and sign in. Many also 
require an active support contract. 

To find more information about support access levels, go to the following URL: 

http://www.hp.com/managementsoftware/access_level

To register for an HP Passport ID, go to the following URL: 

http://www.managementsoftware.hp.com/passport-registration.html

Legal Notices 
© Copyright 2006 Hewlett-Packard Development Company, L.P. 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 
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HP OpenView Smart Plug-in for BEA WebLogic Server


for the HP-UX and Solaris OpenView Operations Management Servers 

Release Notes


Software version: 4.20 / November 2006 

This document provides an overview of the changes made to HP OpenView Smart Plug-in for BEA WebLogic Server (WLS SPI) for the release 4.20. It contains important information not included in the manuals or in online help. 

In This Version
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Installation Notes

Enhancements and Fixes

Known Problems, Limitations, and Workarounds

Support

Legal Notices

In This Version


This release of WLS SPI provides:


· Support for WebLogic Server 9.0, 9.1, and 9.2


· Support for hardware cluster Failover 


· HP-UX MCSG cluster

· Improved error logging and fault tolerance in Discovery functionality 


· BEA Validation (complete) 
New tools and metrics added: 


· Tools 


· Metric Reports tools group 


· B238_EJBCacheHitPct: Generates report for percentage of EJBs in the cache in use 


· WebLogic application group 

· View Application Activation Status: Allows you to view the activation status of applications running on a WebLogic Server 

· View Application Timeout: Allows you to view the time left before retiring applications running on a WebLogic Server will timeout 


· Metrics 


· B016_GloThrePoolOverload: Global Thread Pool overload condition

· B017_WorkloadMgrOverload: Workload Manager overload 

· Application Instance Support:  Application instance level monitoring will allow you to fine tune the WebLogic Server components at the application level


· Support for AIX 5.3 


· Support for Intel Xeon 64 bit processor - EM64T


· Support for HP-UX 11.23 Itanium

Documentation Updates


The first page of this release notes document contains the following identifying information:


· Version number, which indicates the software version.


· Publish date, which changes each time the document is updated.

To check for recent updates or to verify that you are using the most recent edition, visit the following URL:


http://ovweb.external.hp.com/lpe/doc_serv/


In the Product list, click the product name.

2 In the Version list, click the version number.

3 In the OS list, click the OS type.

4 In the document list, click the document title.

5 To retrieve the document, click Open or Download.

NOTE: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To download Adobe Acrobat Reader, go to the following URL:

http://www.adobe.com

Installation Notes


Software Requirements


Service Navigator is not required to run the WLS SPI. However, if you want to view service maps, Service Navigator must be installed.


Management Servers

		Component

		Supported Versions



		HP OpenView Operations for UNIX




		7.1, 8.1, 8.2








Managed Nodes

		Component




		Supported Versions






		WebLogic Application Server 6.1 sp1+

		HP-UX 11.00, 11.11
HP Tru64 5.1A, 5.1B, 5.2 
Solaris 2.6, 7.0
Windows 2000



		WebLogic Application Server 7.0

		HP-UX 11.00, 11.11
HP Tru64 5.1A, 5.1B, 5.2 
Solaris 7, 8, 9, 10 
Windows 2000, 2003 IA64 
Red Hat Enterprise Linux AS/ES 2.1



		WebLogic Application Server 8.1 sp1+

		HP-UX 11.00, 11.11, 11.23, 11.23 IA64
HP Tru64 5.1A, 5.1B, 5.2 
Solaris 8, 9, 10 
Windows 2000, 2003 IA64 
Red Hat Enterprise Linux AS/ES 2.1 (32 bit), 3.0 (32 bit), 4.0 (32 bit)
SuSe Linux ES 8.0 (32 bit), 9.0 (32 bit) 
AIX 5.1, 5.2, 5.3

Intel Xeon 64 bit processor - EM64T



		WebLogic Application Server 9.0 , 9.1, 9.2

		HP-UX 11.11, 11.23, 11.23 IA64
HP Tru64 5.1A, 5.1B, 5.2
Solaris 8, 9, 10
Windows 2000, 2003 IA64
Red Hat Enterprise Linux AS/ES 3.0 (32 bit), 4.0 (32 bit) 
SuSe Linux ES 8.0 (32 bit), 9.0 (32 bit)

AIX 5.1, 5.2, 5.3


Intel Xeon 64 bit processor - EM64T



		HP OpenView Performance Agent  (UNIX or Windows)

		UNIX C.02.00+, Windows C.03.00+, Linux 4.x



		HP OpenView Reporter




		2.x, 3.5, 3.6, 3.7



		HP OpenView Performance Insight




		5.0, 5.1






		HP OpenView Performance Manager (HP-UX, Solaris, Windows)




		4.x, 5.x






		PeopleSoft

		WeblogicVersion: WebLogic Temporary patch 2 for PeopleSoft





Installation Requirements in a Non-Root HTTPS Agent Environment


If you are running or planning to run a non-root HTTPS agent on a UNIX managed node (OVO 8.x only), you must install the OS-dependent Sudo software package on that UNIX managed node. Sudo is free software available from http://www.sudo.ws. The OS-dependent software packages are available at the bottom of the download page (http://www.sudo.ws/sudo/download.html).

Enhancements and Fixes


The following items (identified by error tracking number) are fixed in the current software release.  More detailed information about enhancements and fixes can be found online at the HP Online Software Support web site. The first time you visit this site, you must enter your HP passport information. To set up your passport profile, go to: http://support.openview.hp.com/support.jsp?fromOV=true.


QXCR1000316160: wasspi_wls_ca -r messes up the SERVER numbers in SiteConfig. 
QXCR1000318056: Perl command "use lib" not effective. 
QXCR1000320341: Tracing not working on WLS. 
QXCR1000318561: Discovery not working for T3S and servers created in non-default directories.

QXCR1000337519: No mention of Configuring WLSSPI for WLS running on HTTPS (Inactive)

QXCR1000317620: Metric 85 should use UserLockoutManagerMBean for WLS 7.x and 8.x

QXCR1000328023: deprecated attribute "CacheHitCount" in our MetricDefinitions.xml file

QXCR1000357842:WLSSPI4.00: customer requests hotfix for metric85 (Inactive)

QXCR1000337628: [WLSSPI 4.00] ovtrc3.jar is listed in "Missing Files" by Verify application

QXCR1000381700: collector processes hanging in RHEL 4.0 (Kernel 2.6) environment.


Known Problems, Limitations, and Workarounds


· Problem: On the Windows managed node, the Verify tool gives a message saying there is a version mismatch for the file wasspi_wls_trace.pm

Workaround: This will not cause any problem in the functioning of the SPI. It can be ignored. 


· Problem: In a non-English environment, the message browser does not display error messages correctly.

Workaround:  Change the character set of the WLSSPI Error Log template and redeploy the template. For example, change the character set from “Shift-JIS” to “Japanese EUC.”

· Problem: When multiple managed nodes are selected when running the Discover WebLogic or Configure WebLogic applications, or if the Discover WebLogic and Configure WebLogic applications are run at the same time, the SPI may report errors for one or more selected managed nodes because the SPI configuration file (SiteConfig) for one or more managed nodes has been misplaced.

Workaround:  Run the Configure WebLogic application for each managed node that is reporting errors (run the application on each managed node one at a time).

· Problem: The perl installed with the OVO agent fails to find the OVO perl modules if another application (such as Oracle Application Server) sets the PERL5LIB environment variable to point at locations that do not include the OVO perl lib location. 

Workaround 1: Set the PERL5LIB system environment variable:


1 Prepend C:\Program Files\HP OpenView\nonOV\perl\a\lib (the OVO perl lib path) to the PERL5LIB system environment variable. 

2 Kill the OVO agent: opcagt -kill 

3 Restart the OVO agent: opcagt -start 

4 Check the OVO environment: ovdeploy -cmd set 

5 If the PERL5LIB variable is not set correctly in the OVO environment but the system variable is set correctly, reboot the system.

Workaround 2: 


6 Delete the PERL5LIB system environment variable. 

7 Reboot the system.


8 Run the Discover application.


Workaround 3: Run the discover script on the target node. Enter the following:

9 cd /var/opt/OV/bin/instrumentation


10 wasspi_wls_perl –S wasspi_wls_discovery.pl

NOTE: The service map is not generated when the discover script is run locally (is not run from the OVO management server).


· Problem: The wls.log file grows very large.  


Workaround: Limit the size of the data saved to the log file each time the logfile encapsulator is run. In the SPIConfig file (located in /var/opt/OV/wasspi/wls/conf/ or /var/opt/OV/conf/wls/ on UNIX platforms and /usr/OV/wasspi/wls/conf/ on Windows platforms), add the following:


# maximum number of lines to save to the log file / run
LOG_LINE_LIMIT=16667
# maximum number of characters to save from each log file / run
LOG_SIZE_PER_FILE_LIMIT=600000


· Problem: When using WebLogic Server 6.1, getAttributes returns a null value.  


Workaround:  Install WebLogic Server 6.1 sp7 (service pack 7).


· Problem: On managed nodes using the DCE agent, the /var/opt/OV/wasspi directory and SiteConfig file are not created when running the SPI Discovery or Configuration applications.  The problem may be that the component opctranm may be hung.  


Workaround:  On the management server, run the following commands:


ovstop ovoacomm
rm –f /var/opt/OV/share/tmp/OpC/mgmt_sv/magmgr*
ovstart opc


· Problem: When the WebLogic Server is started, multiple WLSSPI-0011.1: % of execute threads used (<VALUE>%) too high messages are displayed in the message browser. 


Workaround:  These messages can be safely ignored when the WebLogic Server is being started. 

· Problem: When the Self-Healing Info application is run on a Windows managed node, the output file may be hidden.


Workaround:  If you do not see the file, do the following on the managed node:


11 Open Windows Explorer.


12 From the Tools menu, select Folder Options. 


13 Click on the View tab. 


14 Under Hidden files and folders, select Show hidden files and folders.


· Problem:  On a Solaris managed node, the ddflog and dsilog processes hang. The error message WASSPI-1: Unable to create the lock file /var/opt/OV/wasspi/wls/datalog/ddflog.lck. File already exists. is reported and running the command ps –l shows that the ddflog_coda and ddflog or dsilog processes are hung.


Workaround: On each Solaris managed node on which the problem occurs, do the following:


15 In the /var/opt/OV/wasspi/wls/conf/SPIConfig file, set the DATA_LOGGING_EXECUTABLE_NAME property after the “#--------- Dynamic definitions -----------“ entry. DATA_LOGGING_EXECUTABLE_NAME explicitly sets the data logging program that is used (normally, the collector automatically determines the data logging program to use).


If you are running OVPA, set the property to the following value:


DATA_LOGGING_EXECUTABLE_NAME=/opt/perf/bin/dsilog

If you are running CODA, set the property to the following value:


DATA_LOGGING_EXECUTABLE_NAME=/opt/OV/bin/OpC/monitor/ddflog_coda


16 Kill the hung ddflog_coda and ddflog or dsilog processes.


Example excerpt from the SPIConfig file after setting the property:


UDM_GRAPH_CAPACITY=50000
UDM_PERF_CAPACITY=50000
#--------- Dynamic definitions -----------
DATA_LOGGING_ENABLED=TRUE
DATA_LOGGING_EXECUTABLE_NAME=/opt/perf/bin/dsilog


· Problem: The "View Graphs" application does not work. 


Workaround:  On the OVPM Windows system, copy the file:


\Program Files\HP Openview\newconfig\WLSSPI_Graphs.txt


to:


\Program Files\HP Openview\newconfig\VPI_GraphsWLSSPI.txt


· Problem: On Linux nodes, the "Configure SPI" or "Discovery" application can fail without configuring the SPI on the managed Linux node.  This happens because some of the configuration processes require uudecode to be present on the local node.


Workaround:  Ensure that uudecode is installed on the target managed node.  It is available in the SHARUTILS package.


· Problem: The "Start WebLogic" and "Stop WebLogic" applications fail on Windows nodes if the USER or SERVER<n>_USER configuration property is set.  The application is trying to run the "su" command, which is only available on UNIX.


Workaround:  Do not set the USER or SERVER<n>_USER property when configuring the SERVER<n>_START_CMD or SERVER<n>_STOP_CMD properties for Windows nodes.


· Problem: The SPI's configuration log …/wls/log/config.log on a managed node grows without being managed for size.  This file is appended to whenever the SPI's configuration is run, either manually or when the discovery process finds a change that requires configure to run (such as a WebLogic server being added or removed).  Unless there are frequent changes to the environment requiring reconfiguration, this should not be a problem.


Workaround:  Manually delete the file if it gets too large.


· Problem: WebLogic Server SPI cannot locate and therefore is unable to monitor the WebLogic log file when WebLogic Server is not started from the HOME directory.   This is only a problem in WebLogic Server 6.0 and 6.1.

The location and name of the WebLogic Server log file is specified in the WebLogic Administration Console in the "Logging" tab on the server configuration page. If this log file is specified with a relative path, this path is relative to the directory in which the WebLogic Server is started. The default is the WebLogic home (WL_HOME) directory specified when the WebLogic SPI is configured. The startup scripts installed by BEA start WebLogic Server from its home directory. 


No means currently exists for querying the server for its startup directory.  So, if the WebLogic Server is started up in a directory other than WL_HOME and the log file is specified as a relative path, the WLSSPI may not be able to locate and monitor the WebLogic Server log file.


Workarounds (choose either A, B, or C): 


(A) Configure the LAUNCH_DIR variable in the WebLogic Server SPI configuration file to define the location of the WebLogic Server startup directory. Please see Chapter 2 of the User’s Guide for details.


(B) Ensure that WebLogic Server is started from the WL_HOME directory, which is the default if you use the startup scripts provided by BEA. Also, note that the WLSSPI will not recognize a fully qualified path name for the log file. You must use a relative path for the WebLogic Server log file in order for it to be located and monitored by the WLSSPI.


(C) In the WLS SPI configuration file, include the fully qualified name(s) of the WebLogic Server logfile(s) you want to monitor. For multiple logfile entries, separate each logfile name with a comma.


To edit the file:


17 Run the WLSSPIWLSSPI AdminConfig WLSSPI application to edit the file. 


18 Insert an additional line beginning with keyword SERVER<n>_LOGFILE as shown below, followed by the fully qualified file name:  


SERVER<n>_LOGFILE = <path>/<file_name_1>,</<path>/<file_name_2>

19 Save the file and deploy to the node.


NOTE: This workaround is an enhancement to the syntax as documented in the HP OpenView Operations Smart Plug-in for BEA WebLogic Server Configuration Guide. 


· Problem: Two Netscape Navigator browser windows are launched when running the View Graphs application. The top window obscures the OVPM function buttons in the lower window. 


Workaround:  This problem only occurs with Netscape Navigator version 4.79. Use Netscape Navigator version 6.0 or higher.

· Problem: The Web browser cannot be launched from an operator action after you have correctly configured the WLS SPI as instructed in the “Configure the Management Server to Launch your Web Browser” task in chapter 2 of the HP OpenView Operations Smart Plug-in for BEA WebLogic Server Configuration Guide. 


Workaround:  


20 Stop and restart the agent from a user other than root by entering the following commands on the managed node:


opcagt –kill
opcagt –start


21 Run the operator action. 


· Problem: Netscape fails to refresh graphing data. Specifically, when you use Netscape as the browser to graph your data (graphing capability included with Reporter 3.0 or higher), the browser fails to refresh when new selections are made. 


For example, in the OVO console after you drag and drop a managed node onto the WLSSPI Admin application View Graphs, Netscape appears and displays a blank WLS SPI graphing page where you can accept or change the following default selections:


Server:  MyServer_1
Graph Name:  Serverstat
Data Range: 7 Days (ending now)


By clicking Draw, you successfully generate the graph. 


However, when you select a different server, let’s say MyServer_2, you see that the graph that appears after you click the Draw button is the same graph/data as the one you just viewed (for MyServer_1). 


Workaround:

22 In Netscape from the Edit menu select PreferencesAdvancedCache.


23 In the segment labeled Document in cache is compared to document on network, select radio button Never.


24 After successfully generating the first WLS SPI graph, for any subsequent graphs, always change a minimum of two selections to refresh the data; for example select a different server and a different graph; or select a different graph and a different date range. Any two differing selections work to clear the current graph data from the browser cache.


25 Note: The underlined text Refresh Graph Now at the bottom of the Web page does not work; when clicked, it may return the error: the parameter is incorrect.


· Problem: For a managed node running Red Hat Linux 4 or Suse Linux 9.1 or 9.2, discovery and/or metric threshold monitor alarming is not functioning AND the following error message is found in the SPI error log:


*** glibc detected *** double free or corruption: 0x0937d008 ***


Workaround:  On the OVO agent, set the MALLOC_CHECK_ environment variable to 0 (zero) and restart the agent.

Support


Please visit the HP OpenView support web site at:

http://www.hp.com/managementsoftware/support

This web site provides contact information and details about the products, services, and support that HP OpenView offers.

HP OpenView online software support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage your business. As a valued support customer, you can benefit by being able to:

· Search for knowledge documents of interest

· Submit and track progress on support cases

· Submit enhancement requests online


· Download software patches


· Manage a support contract

· Look up HP support contacts

· Review information about available services

· Enter discussions with other software customers 


· Research and register for software training

NOTE: Most of the support areas require that you register as an HP Passport user and sign in. Many also require an active support contract.

To find more information about support access levels, go to the following URL:

http://www.hp.com/managementsoftware/access_level

To register for an HP Passport ID, go to the following URL:

http://www.managementsoftware.hp.com/passport-registration.html

Legal Notices


© Copyright 2006 Hewlett-Packard Development Company, L.P.

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.


The information contained herein is subject to change without notice.
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